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QuickBooks III - Agenda

� Benefits of using the audit trail feature

� Creating reports
QuickReports
Customizing
Filtering
Creating memorized report groups
Processing reports in groups
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Processing reports in groups
Exporting to Excel
QuickInsight graphs

� QuickBooks and year-end
Analyzing assets and liabilities
Journal entries
Year-end accruals
Accountant’s review copy

� Generating letters 

� Customizing forms



What’s Next?

� QuickBooks IV
How to set up employees and payroll tax reports
How to use QuickBooks to process and record all 
aspects of payroll
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Introduction

� Ice breaker:  discuss with others 
your #1 headache when it is time 
for your auditor’s visit.  What 
takes the most time? What do you 
dread? What do you wish were 
different?

4



Keeping Fraud From Knocking 
On Your Door



Preventing Fraud

� QuickBooks has several features to help improve 
the control of monies and to prevent fraud. 

� Software cannot do it alone.
We need to keep in mind that it takes numerous

measures to protect against embezzlement including 
dual controls, audits, and good hiring practices.
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Using QuickBooks for Control

� QuickBooks includes a number of standard 
features to help improve control. 
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Audit Trail

� In QuickBooks there is an audit trail feature that 
may be turned on to track all transactions and 
modifications or deletions. 
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Audit Trail

� The Audit Trail Report provides a summary to 
the Administrator of all QuickBooks transaction 
activity answering three essential questions:

1. Who added/edited/deleted the transaction?
2. When was the transaction added/edited/deleted? 
3. What were the relevant details of the transaction, 
i.e., date, amount, accounts, names, etc.?
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i.e., date, amount, accounts, names, etc.?



Audit Trail

� You can also set a password for making changes 
in previous periods.
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Closing the Books

� You may also close the books which will require a password to 
make changes in previous periods; this is optional as well.

11



Setting User Roles

� This capability is frequently overlooked, and is one 
component of higher levels of fraud protection.
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Limiting User Roles

� Set up the user permissions to disallow deletes and changes 
within that user's role. Just this one step alone will prevent the 
user from changing anything after the fact, or deleting a 
transaction in order to cover up fraud. 
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� Unless you grant full access to QuickBooks, multiple 
screens allow the user no, full or partial access to 
different segments of the accounting workflow.

15



Audit Trail Report

� The Audit Trail Report provides a record of every transaction 
entered into the data file, including details such as when a 
transaction is changed and the nature of the change. At a 
minimum, it is suggested that report be examined on at least a 
weekly basis, looking for any suspicious activity.

� Examples of such activity include:
unauthorized bad debt write-offs or other credits to customer 
accounts, journal entries to cash accounts, or changes to the 
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accounts, journal entries to cash accounts, or changes to the 
payee on checks.
customer invoices being deleted. This could indicate that an 
employee received cash from the customer, and then deleted the 
invoice so he/she could pocket the cash.



Other Elements of Good Control

� Separate Reconciliations from Payroll Issuer

� Signing Authority

� Education
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Separate Reconciliations from Payroll 
Issuer

� It's important to have a different person 
reconcile the bank statement than the person 
who issues the Accounts Payable and Payroll 
checks. 
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Signing Authority

� The person issuing the Accounts Payable checks 
should not be the person authorized to sign 
them. 
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Education

� There is quite a bit of control in QuickBooks, but it is 
flexible enough if the user doesn't want to deal with 
these features. While most of these control features 
are optional, it is important that the user understand 
why they are important, and to implement them  as 
appropriate. 

� If the user knows what the tool is and how it works, 

20

� If the user knows what the tool is and how it works, 
that is the key. 



Preventing Fraud

Top Ten TipsTop Ten Tips



Send Bank and Credit Card Statements 
to a Separate Address

� Review each check both front and back for 
payee, signature, and endorsement.

� Examine each statement carefully. Review each 
and every line item of both payments and 
charges.
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� Never allow someone to use your password, sign 
your name, ever. 

� Never let an employee sign your name, use your 
credit card, or misrepresent themselves to your 
bank or credit card company. Reimburse their 
expense. 

Do Not Let Anyone Misrepresent 
Themselves as You 
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� Don’t reveal sensitive passwords. 



Reconcile Bank Accounts and Review 
Statements 

� Review every statement. Make sure all bank accounts 
and credit cards are reconciled. 

� Take time to review every reconciliation report. 

� Notice stale checks or deposits that have not cleared 
the bank. 

� Check for missing deposits. An increase in the 
number of reconciled items may also reveal mischief. 
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� Check for missing deposits. An increase in the 
number of reconciled items may also reveal mischief. 



Assign Administrative Rights Effectively 

� Use the Administrative rights in QuickBooks to 
protect your data. 

� This role has unique permissions. 

� Make sure that every user is set up separately 
and that passwords are used.

Lock down permissions to change or delete 
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� Lock down permissions to change or delete 
transactions. 

� Especially important: Use passwords for closing 
dates. 



Use the Audit Trail in QuickBooks 

� If you don’t have the latest version of QuickBooks, 
make sure you turn on the Audit Trail. 

� Caution: the Audit Trail won’t tell you if a vendor 
name has been changed or merged. It is wise to 
maintain a strict paper trail. 

� Supporting documents need to be readily accessible 
in your files and then archived according to the type 
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in your files and then archived according to the type 
of document. 



Use the Voided/Deleted Transaction 
Report 

� After you have turned on the Audit Trail, and 
made its review part of your routine, 
periodically review the Voided/Deleted 
Transaction Report to see which entries which 
have been modified. 
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Establish Accounting Controls 

� Split responsibilities between staff members or 
outside accounting professionals. 

� Warning Sign: If only one person writes the checks 
and reconciles the account, there is no double check. 
Separate the duties. 

� Consider another person to do reconciliations so it is 
done by a person other than the staffer generating 
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done by a person other than the staffer generating 
the checks. 



Adhere to a Numerical Sequence 

� Use a numerical sequence for all transactions. 
Invoice, bills, and checks which are numbered fall in 
a logical and chronological order. The reason: To 
identify missing documents. 

� Look at the bank statement for large gaps. Secure 
paper checks. 

� If you keep voided paper checks, remember to tear 
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� If you keep voided paper checks, remember to tear 
off the signature area to keep it from being misused. 
If your bank sends paper checks, sort them 
numerically. 



Review Receivables and Payables 

� Look for adjustments to Receivables or Payables. 
Such adjustments could indicate subverted 
payments or vendor checks. 

30



Back up Your Data 

� Back up!  Back up!  Back up!

� Think redundant backups as a contingency plan for disasters of 
all sorts. 

� Make scheduled copies. 

� Rotate the media (tape drive or portable storage). If you use 
CDs, better buy the read-only variety. 

� Store your backups at another location. Such diligence can 
come in especially handy if there is a disaster. 
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Store your backups at another location. Such diligence can 
come in especially handy if there is a disaster. 

� In some fraud cases, the bookkeeper may delete all of the 
QuickBooks files to avoid detection. In such cases the 
governments have to pay a large sum for data retrieval, in 
hopes of capturing any shred of evidence. Be smart; back up. 
It only takes a few minutes.



Creating Reports



Benefits of reports

� Entering data doesn’t provide an opportunity to 
analyze

� Reports let you summarize your financial data
Helps in making decisions

� Provide bottom line
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Lesson objectives

� To discuss some of the tools QuickBooks gives you for 
analyzing financial data: QuickReports, preset reports, and 
graphs

� To create a QuickReport

� To add a column to a report

� To learn how to move a column in a report

� To learn about the types of preset reports QuickBooks offers

� To practice creating reports and viewing them onscreen
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� To practice creating reports and viewing them onscreen

� To customize a report by changing how it looks and the data it 
covers (filtering)

� To learn how to process reports in batches

� To save reports as Portable Document Format (PDF) files

� To learn how to export a report to Microsoft Excel

� To practice filtering reports in Microsoft Excel

� To learn about the types of graphs QuickBooks offers

� To create and customize several graphs



QuickReports

� Predesigned reports that give you information 
about the items your are currently viewing on 
screen
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When to use a QuickReport

To see what you owe a vendor:

1. Click Vendor Center on the navigation bar.

2. Select Patton Hardware Supplies.
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3. In the Reports for this Vendor section, click the 
QuickReport link.

When to use a QuickReport
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Zooming in on a QuickReport

To see more detail about an item:

1. Position the mouse pointer over the item 
receipt dated 12/05/07.
� The arrow pointer turns into a magnifying glass with 

the letter Z (z for zoom)

2. Double-click the item receipt.
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2. Double-click the item receipt.

3. Click Save & Close to close the window.
� QuickBooks returns you to the QuickReport



Customizing QuickReports

To add a column to a report:

1. In the QuickReport window, click Modify 
Report.

2. In the Columns list, select Trans #.

3. Click OK to accept the change.  QuickBooks 
displays the customized vendor QuickReport.
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Customizing QuickReports

To move a report column:

1. Position your mouse pointer over the Trans # 
column that you added to the QuickReport.

2. Hold down the left mouse button and drag the 
Trans # column to the right until you see an 
arrow between the Date Column and the Num 
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arrow between the Date Column and the Num 
column.

3. Release the mouse button.  QuickBooks places 
the Trans # column between the Date column 
and the Num column.



Customizing QuickReports

To change information in the report heading:

1. In the QuickReport window, click Modify 
Report, and then click the Header/Footer tab.

2. In the Report Title field, highlight the text for 
“Vendor QuickReport,” and type Vendor 
History Report to replace the title.
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History Report to replace the title.

3. Click OK to close the Modify Report window.



Customizing QuickReports
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� Close the QuickReport window.

� Close the Vendor Center.



Creating and customizing present 
reports

� In addition to QuickReports, QuickBooks has 
dozens of present report formats.

Company & Financial
Customers & Receivables (accounts receivable 
reports)
Sales reports
Jobs, Time & Mileage reports
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Jobs, Time & Mileage reports
Vendors & Payables (accounts payable) reports
Purchases reports
Inventory reports
Employees & Payroll reports
Banking reports
Accountant & Taxes reports
Budget reports
Lists reports



Report center

� An excellent way to learn about the reports 
available in QuickBooks – and how to work with 
them.

� Contains a description and example of each 
QuickBooks report.

“Learning” link in the center takes you to a window 
in which you can launch a video tutorial that 
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“Learning” link in the center takes you to a window 
in which you can launch a video tutorial that 
provides an overview of QuickBooks reports as well 
as links to several help topics about working with 
reports.



Creating a balance sheet comparison report

To create a balance sheet comparison report for
Rock Castle Construction:

1. In the Report Center, choose Company & 
Financial. Then choose Balance Sheet Prev 
Year Comparison.

2. Scroll the report window to see more of the 
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2. Scroll the report window to see more of the 
report.

3. Click the Collapse button to see the difference.

4. Click Expand to return to the original report 
display.

5. Keep the report displayed on your screen. 
You’ll use it in the next exercise.



Filtering reports

� In the next exercise, you will customize the 
balance sheet comparison report and filter it to 
include only the transactions you specify.

� Report filters let you set custom criteria for the 
transactions you want included in a report.  
When you filter a report, QuickBooks includes 
only those transactions that match the rules you 
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only those transactions that match the rules you 
create.



Filtering reports

To filter a preset report:

1. With the balance sheet comparison report 
displayed, click Modify Report on the report 
button bar, and then click the Filters tab.

2. In the Filter scroll box, make sure Account is 
selected.
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selected.

3. In the Account field, choose All assets.

4. Click OK.



Filtering Tips

� Some filters represent more than one thing 
which can be confusing if you’ve never used 
report filters.

Use “Item” to filter for any kind of line item that 
appears on a purchase order or sales form. These 
include goods and services, discounts, and sales tax.
Use “Name” to filter for customers, jobs, vendors, 
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Use “Name” to filter for customers, jobs, vendors, 
employees, or any name on the Other Names list.
Use “Transaction type” to filter for any type of 
transaction, including invoices, cash sales, statement 
charges, payments from customers, bank deposits, 
purchase orders, item receipts, bills, bill payments, 
credit card charges, checks, paychecks, and
general journal entries.



Saving reports as a PDF

To save a report as a PDF file:

1. With the report open, choose “Save as PDF” 
from the File menu.

2. Navigate to the folder in which you want to 
store the file, and enter a filename.

3. Click Save.
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3. Click Save.

4. Close the report window.

5. Click No when QuickBooks asks if you want to 
add this report to the Memorized Report list.



Creating and customizing a sales report

To create a sales report:

1. From the Reports menu, choose Sales, and then 
choose Sales By Customer Summary from the 
submenu.

To customize a report:
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To customize a report:

1. In the Dates field, select Custom from the drop-
down list.

2. In the From field, enter 01/01/2007.

3. In the To field, enter 01/31/2007 and press Tab.

4. From the Dates field, choose All from the drop-
down list.



Using QuickZoom in a preset report

To QuickZoom on a report item:

1. Position the mouse pointer over the 
$11,105.00—the amount for Anton Teschner’s 
sun room.

2. Double-click $11,105.00.

3. QuickBooks displays a QuickZoom report 

51

3. QuickBooks displays a QuickZoom report 
showing sales by customer detail.



Using QuickZoom in a preset report

52



Using QuickZoom in a preset report

To QuickZoom further to display the original 

invoice for a transaction:

1. Position the mouse pointer over the first item 
on the report (invoice #40 dated 10/05/2007 
for Removal labor).

2. Double-click anywhere in the first line.
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2. Double-click anywhere in the first line.



� Notice that QuickBooks puts a paid stamp on 
invoices for which payment has been received in 
full.

Using QuickZoom in a preset 
report
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3. From the Window menu, choose Close All.

4. Click No when QuickBooks asks if you want to 
memorize the report.

5. Click Home in the navigation bar to display the 
Home page.

Using QuickZoom in a preset 
report
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Report tips

� You can widen or narrow columns on any type of 
QuickBooks report.

To make a column wider, drag the small diamond at 
the right of the column header toward the right. 
To make a column narrower, drag the small diamond 
at the right of the column header toward the left.
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Creating memorized report groups

� In addition to saving report settings, you can 
create memorized report groups that you can 
use to organize your memorized reports in a way 
that makes sense for your government and allow 
you to quickly process a group of reports at 
once.

� QuickBooks comes preset with a number of 
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� QuickBooks comes preset with a number of 
memorized report groups each containing 
common reports for each area. You can add your 
own reports to these groups, modify the groups 
to meet your needs, and even create your own 
groups.

� In this exercise, you’ll create a memorized group 
called “Year End” to which you will add some 
memorized reports. Later, you’ll learn how you 
can batch process memorized reports.



Creating memorized report groups

To create a memorize report group:

1. Choose Memorized Reports from the Reports 
menu, and then choose Memorized Report List.

2. In the Memorized Report list, click the 
Memorized Report menu button, and choose 
New Group.
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Creating memorized report groups

To create a memorize report group:

3. In the Name field of the New Memorized Report 
Group window, type Year End.

4. Click OK.

59



Memorizing preset reports

� Next, you’ll memorize a report and add it to 
the memorized report group you just created.

To memorize a report:

1. From the Reports menu, choose Accountant & 
Taxes, and then choose Income Tax Summary.

2. On the report button bar, click Memorize.
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2. On the report button bar, click Memorize.

3. Leave the name of the report as is.

4. Click the “Save in Memorized Report Group” 
checkbox to select it, and then choose Year 
End from the drop-down list.

5. Click OK to memorize the report and add it to 
the Year End memorized report group.

6. Close the income tax summary report.



Adding reports to memorized report groups

To add memorized reports to a memorized report group:

1. In the Memorized Report List window, select the report called 
“1099 Summary--Year End.”

2. Click the Memorized Report menu button, and then choose 
Edit Memorized Report.

3. Leave the report name as is.

4. Click the “Save in Memorized Report Group” checkbox to 
select it, and then choose Year End from the drop-down list.
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select it, and then choose Year End from the drop-down list.

5. Click OK.

6. In the Memorized Report List window, select the report called 
“Balance Sheet--Year End.”

7. Click the Memorized Report menu button, and then choose 
Edit Memorized Report.

8. Leave the report name as is.

9. Click the “Save in Memorized Report Group” checkbox to 
select it, and then choose Year End from the drop-down list.

10.Click OK.



Adding reports to memorized report groups

To display a memorized report:

1. In the Memorized Report list, select “Balance 
Sheet--Year End.”

2. Click Display.

3. Leave the report open.
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Printing reports

To print a report:

1. With the balance sheet summary report 
displayed, click Print.

2. Click Preview to see how the report will look 
when you print it.

3. QuickBooks displays a preview of your report 
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3. QuickBooks displays a preview of your report 
onscreen.

4. Click Close to close the Print Preview window.

5. Close the Print Reports window, and then close 
the report.



Processing reports in groups

� Organizing your memorized reports in groups 
makes it fast and easy to process several 
reports at once.  Now, you’ll process the 
reports you added to the Year End report group 
you created in the previous exercise.
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Processing reports in groups

To batch process reports:

1. In the Memorized Report list, select Year End.

2. Click Display.
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3. Leave all three reports selected and click 
Display.

4. From the Window menu, choose Close All.



Exporting reports to Microsoft 
Excel

� Occasionally, you may want to change a report’s 
appearance or contents in ways that aren’t 
available in QuickBooks, filter report data in 
ways that you can’t in QuickBooks, or run “what-
if” scenarios on your QuickBooks data.

� You can send reports from QuickBooks to 
Microsoft Excel. Since the changes you make in 
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Microsoft Excel. Since the changes you make in 
Excel don’t affect your QuickBooks data, you’re 
free to customize reports as needed, and even 
change data to run what-if scenarios.



� When exporting a report to Microsoft Excel, you 
indicate whether or not you want to preserve 
the formatting from your QuickBooks report. You 
also have the option of turning on or off several 
Excel features from within QuickBooks.

� By default, QuickBooks preserves the look of 
your report when exporting to Microsoft Excel, 
and turns on the following Excel features:

Exporting reports to Microsoft 
Excel
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your report when exporting to Microsoft Excel, 
and turns on the following Excel features:

AutoFit sets column widths in Excel wide enough to 
display your data without cutting off words or 
numbers.
Freeze panes allows you to scroll through data while 
keeping the row and column headers in view.
Show Gridlines turns on gridlines in Excel.

� In this exercise, you learn how to select which 
QuickBooks report formatting options you want 
to preserve in Excel, and how to turn on and off 
certain Excel features from within QuickBooks.



Sending a report to Microsoft Excel

To send a report to Microsoft Excel:

1. From the Reports menu, choose Company & 
Financial, and then choose Balance Sheet 
Standard.

2. On the Report button bar, click Modify Report.
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Sending a report to Microsoft Excel
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3. In the “Add subcolumns for” area, click the 
Previous Period checkbox, and then click the 
$ Change and % Change checkboxes.

4. Click OK.

5. On the Report button bar, click Export.



Sending a report to Microsoft Excel

To send a report to Microsoft Excel:

6. On the Basic tab, make sure that “a new Excel 
workbook” is selected.

7. Click the Advanced tab.

8. Under Formatting options, click the Colors 
checkbox to clear it.
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checkbox to clear it.

9. Under Excel features, select the Auto Filtering 
checkbox.

10.Click Export.

11.Leave the report open in Excel; you’ll use it in 
the next exercise. 



Filtering a report in Microsoft 
Excel

� You can filter on any column of data using a 
drop-down list at the top of the column.

� Using the drop-down list, you can apply a 
number of preset filters or create your own 
custom filter.
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Filtering a report in Microsoft 
Excel

To filter a report in Microsoft Excel:

1. In the Excel window, click the down arrow in 
the $ Change column of the balance sheet 
report, and choose (Custom...).

2. In the $ Change field, choose “is less than” 
from the drop-down list.
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from the drop-down list.

3. In the field to the right, type 0.

4. Click OK.

5. Close Excel without saving the report.

6. Close the balance sheet report in QuickBooks.

7. Choose No when QuickBooks displays a message 
asking if you want to memorize the report.



Creating QuickInsight graphs

� A graph is an invaluable tool that provides a 
visual picture of your finances.

� A QuickInsight graph shows your data pictured as 
either a bar graph or a pie chart.

� QuickBooks has six types of graphs, providing up 
to 15 different views of your data:
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to 15 different views of your data:
Income and Expense graphs
Sales graphs
Accounts Receivable graphs
Accounts Payable graphs
Net Worth graphs
Budget vs. Actual graphs



Creating an Income and Expense graph

To create an income and expense graph:

1. From the Reports menu, choose Company & 
Financial, and then choose Income & Expense 
Graph.
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Creating an Income and Expense graph

� In the top portion of the graph window, QuickBooks 
displays a bar graph and legend showing total income 
and expenses.  

� In the lower portion of the window, QuickBooks displays 
a pie chart and legend showing expense percentages by 
account.
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Creating an Income and Expense graph

� QuickBooks can display only 10 accounts at a time. 
To display more accounts, click the Next Group 
button at the top of the graph window.
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Features of QuickInsight graphs

� Every graph window, except for the Net Worth and 
the Budget vs Actual graphs, shows a bar graph in the 
top part of the window and a pie chart in the bottom 
half.

� The bar graph usually shows totals. For example, the 
Income and Expense graph shows the total for income 
and the total for expenses in each month of the 
period.
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period.

� The pie chart shows a breakdown of the information 
shown in the bar graph; each pie slice in the Income 
and Expense graph represents a type of income or 
expense.



Features of QuickInsight graphs

� The legend to the right of the pie chart shows you 
which income or expense account corresponds to the 
color shown in the pie chart; it also shows you what 
percentage of the pie each slice represents.

� Every graph window has a buttonbar with buttons you 
can click to customize the graph. For example, you 
can change the time period shown in the graph by 
clicking the Dates button. If you want the pie chart to 
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clicking the Dates button. If you want the pie chart to 
show a breakdown by customer or class rather than a 
breakdown by account, just click By Customer or By 
Class.



Features of QuickInsight graphs

� Just as you can use QuickZoom in a report to get 
more detail on the numbers, you can use 
QuickZoom in a graph to see the numbers behind 
the picture. 

� When you double-click a bar or pie slice, 
QuickBooks shows you the numbers represented 
by that graphic image. 
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by that graphic image. 
For example, the pie chart legend tells which 
income/expense accounts are represented by each 
pie slice, and tells you what percentage of the whole 
is represented by each slice. 
When you zoom in on a pie slice, you can find out 
exactly how much you received or spent (in dollars) 
for each account.



Creating an Income and Expense graph

To display income accounts instead of expense 
accounts:

1. Click Income at the bottom of the graph 
window.

2. Click By Customer.
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Using QuickZoom with graphs

To display the sales for Anton Teschner:

1. Position the mouse pointer over the Teschner, 
Anton slice of the pie chart.

2. Double-click the Teschner, Anton slice.
� If a slice is too small to click, click on its legend 

representation instead.
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representation instead.

QuickBooks displays a QuickZoom graph depicting 
sales for Anton Teschner by month.



Using QuickZoom with graphs
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Using QuickZoom with graphs

To display a report describing the transactions for
a given month:

1. Position the mouse pointer over the bar representing 
November 2007. The pointer turns into the QuickZoom 
symbol.

2. Double-click the bar.

83

2. Double-click the bar.

QuickBooks displays the custom transaction detail 
report for the month of November 2007.



Using QuickZoom with graphs
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Using QuickZoom with graphs

To display the first transaction in the report:

1. Double-click any of the lines in the report for 
Invoice #60.

2. From the Window menu, choose Close All.
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Customizing how graphs display

To change from 3D to 2D:

1. From the Edit menu, choose Preferences.

2. In the left panel, click Reports & Graphs.

3. Click “Draw graphs in 2D (faster).”

4. Click OK.
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4. Click OK.

5. From the Reports menu, choose Sales. Then 
choose Sales Graph.



Customizing how graphs display
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Review activities

� Create a QuickReport on an item in one of Rock 
Castle Construction’s lists.

� Rock Castle Construction wants to create a report 
that shows how much they have spent on lumber for 
projects during November, 2007. Create an item 
summary purchase report, covering the date range 
from 11/01/2007 to 11/30/2007. Filter the report to 
show only Rock Castle Construction’s purchases for 
Lumber.

88

Lumber.

� Batch process the balance sheet, profit and loss 
statement, and statement of cash flows using the 
Process Multiple Reports window.

� Use the Report Center to find reports that show the 
following:

Sick and vacation balances for each employee
Time spent on each job
Inventory stock on hand and reorder point
Customers with overdue payments, how much they owe, 
and their phone numbers
How much of total sales is taxable, at what rate, and how 
much sales tax is currently due to be paid



Using QuickBooks to Prepare 
for Year-End



Balance Sheet

The balance sheet includes account balances as of 
a specific date in time.  For example –

City of XYZ

Balance Sheet
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June 30, 20XX



Balance Sheet Accounts

� Assets
Cash
Accounts Receivable
Allowance for Uncollectible Accounts
Due from Other Governments (State or Local)
Prepaid Assets

91



Balance Sheet Accounts

� Liabilities
Accounts payable
Due to Other Governments
Accrued liabilities (salaries, benefits, and 
compensated absences)
Deferred revenue

� Fund Balance
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� Fund Balance
Reserved
Unreserved 



ASSETS - CASH

� Auditors need reconciled bank statements for the last 
date of the fiscal year 

� No amounts other than deposits in transit and 
outstanding checks required to reconcile the 
statement

� Reconciliation does not agree with your accounting 
records, find the difference by comparing 

93

records, find the difference by comparing 
transactions listed on the bank statement with those 
recorded in your cash account 



ASSETS-CASH

Things to remember

� Correctly date transactions
Checks must actually have been released; 
i.e. mailed or otherwise distributed.  Checks 
that have not been released are not 
considered outstanding and will be added 
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considered outstanding and will be added 
back to your account balance as an audit 
adjustment.
If you post a deposit to QuickBooks that you 
have not taken to the bank, the auditors 
may adjust your records by this amount.

� Review list of outstanding checks



ASSETS-CASH

Supporting Documentation for Audit (June 30 year-end 
example)

June 30th bank reconciliation
June bank statement
July and August bank statements
General ledger cash account balances
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General ledger cash account balances



ASSETS- ACCOUNTS RECEIVABLE

� Represents amounts due from customers 
resulting from a business transaction.  

� What are some accounts receivable accounts 
that are the most important at year-end?

� It is important that an accounts receivable report 
be run as of the close of business the last day of 
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be run as of the close of business the last day of 
the fiscal year.

� An auditor will want to see the detail supporting 
the total Accounts Receivable balance by 
customer and amount.

Export the file to Excel 



Allowance for Uncollectible

� Once you have the total Accounts Receivable 
balance, you must determine how much of the 
total is likely to be collected.

� You can generate reports in QuickBooks to 
determine the history of collections.

� To post the journal entry for Accounts 
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� To post the journal entry for Accounts 
Receivable, you must estimate what you will 
receive in collections during your availability 
period. 

� The difference between the total Accounts 
Receivable, Allowance for Doubtful Accounts and 
available revenue, will equal Deferred Revenue.



Journal Entry

� The amount that needs to be booked in the 
Property Taxes Receivable account is $100,000.  
This is the amount of property taxes owed based 
on the digest.  The revenue account for property 
taxes also needs to be booked for $100,000.

� You have received $75,000 of the $100,000 
owed.
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owed.

� You know that from your history of collections, 
Leesville collects approximately 97% of the 
amount levied.  Therefore, $3,000 is the amount 
that will most likely never be collected.

� The remaining balance is considered deferred 
revenue.



Journal Entry

Debit Allowance for uncollectible delinquent taxes

Debit Property tax revenue

Debit Deferred revenue

Credit Accounts Receivable
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Creating a journal entry

1. You will need to create new accounts for the 
following:
� Real property – prior year
� Taxes receivable – current
� Allowance for uncollectible current taxes
� Deferred revenue
� Cash

2. Go to the Company menu and click Make 
General Journal Entries.

100

2. Go to the Company menu and click Make 
General Journal Entries.

3. In the Make General Journal Entries window, 
change the date if necessary.

4. Fill in the entry number.

5. Check the adjusting entry checkbox, as 
appropriate.

6. In the detail area, enter distribution lines.

7. Save the journal entry.



Liabilities

� Accounts payable are amounts owed to vendors 
at the end of the accounting period.

� Use QuickBooks to produce a listing by vendor 
and amount for total outstanding invoices.
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Review activities

� Go to the Report Center and create a report that 
lists vendor and amount for outstanding total 
invoices.
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Accruals

� Receipt of goods
It is important to identify those items that were 
received by the last date of the fiscal year.  Once 
you receive goods or services, you have an obligation 
to pay and therefore a liability exists.

If the invoice is received after the end of the fiscal 
year, enter the amount with a June 30th (or your 
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If the invoice is received after the end of the fiscal 
year, enter the amount with a June 30th (or your 
fiscal year) post date into the accounting system.  
This will result in the expenditure appearing in the 
correct fiscal year.



Accruals

� Recurring invoices
Invoices paid for recurring services should be 
evaluated to determine twelve expenditures are 
posted for the period.

� Unrecorded transactions
One of the items auditors will request is the check 
register for the first two months after year-end.  
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register for the first two months after year-end.  
They will ask you to pull certain payments made 
during this time so they can determine if there are 
any invoices paid that pertain to the fiscal year they 
are auditing.  If they find a significant payment that 
should be in accounts payable, they will prepare an 
audit adjustment to record it.



Payroll accrual

� At year-end, amounts are typically owed to 
employees for time worked through year-end 
that has not yet been paid.

� An accrual must be posted dated June 30th, (or 
your year-end date) for the portion of a payroll 
paid in July that covers time worked in June.
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� Example:  payroll totaling $20,000 was paid July 
11th.  The payroll covered 5 days worked in June 
and 5 days worked in July.  Based on this 
information, what journal entry in QuickBooks 
would need to be made in June?

� Using QuickBooks, what journal entry needs to 
be made on July 11?



Payroll accrual - solution

� In June, the expenditure would be recorded as 
follows:

Debit Salary Expenditure $10,000 (June portion)
Credit Salaries payable $10,000

� Once salaries are actually paid, the expenditure 
would be recorded as follows:
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would be recorded as follows:
Debit Salaries payable $10,000
Debit Salary Expenditure $10,000 (July portion)
Credit Cash $20,000



Accountant’s review copy

� Suppose your accountant wants to make some 
adjustments to your books, but you cannot 
afford to lose access to your books yourself.

� By giving an accountant’s review copy of your 
data to your accountant, you can continue your 
day-to-day operations with QuickBooks while 
your accountant enters the adjustments.
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your accountant enters the adjustments.

� When your accountant finishes, you merge the 
accountant’s changes along with your own.  At 
no point during the process do you lose the 
ability to work with your QuickBooks data 
yourself.



How to create an accountant’s 
review copy

� Go to the File menu, choose Accountant’s 
Review, and then click Create Accountant’s 
Copy.

� (Optional) Change the filename that QuickBooks 
suggests for the accountant’s copy.  The file 
must have a .QBX extension.
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� Click Save.  The phrase “Accountant’s copy 
exists” appears in the title bar of the QuickBooks 
program window.



Merging your accountant’s 
changes

1. If the file is on a disk or CD-ROM, insert it into 
your drive.

2. Open the master company file.

3. Go to the File menu, choose Accountant’s 
Review, and then click Import Accountant’s 
Changes.
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Changes.

4. When the message about backing up your data 
appears, click OK.
� Backing up is a safeguard in case anything goes 

wrong when you try to merge the changes.

5. Enter the filename and location for the backup 
file and click Back Up.

6. In the Import Changes from Accountant’s copy 
window, enter the filename and location of the 
accountant’s changes and click open.



Using QuickBooks to Creating 
Letters



Preparing collection letters

To prepare a collection letter:

1. From the Company menu, choose Prepare Letters with 
Envelopes, and then choose Collection Letters.

2. If QuickBooks prompts you to find letters, click Copy. 
QuickBooks will copy the QuickBooks letters from your 
installation directory to your QBtrain folder.

QuickBooks opens the Letters and Envelopes wizard.
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QuickBooks opens the Letters and Envelopes wizard.

3. When QuickBooks prompts you to choose who you 
want to write to, make the following selections:

� For number 1, choose Active.
� For number 2, choose Customer.
� For number 3, choose 31 days or more.



Preparing collection letters

� Your screen should look like this.
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Preparing collection letters 

4. Click Next.

5. Leave all of the names selected and click Next.

6. When QuickBooks prompts you to choose the letter 
you want to use, click “Friendly collection” and click 
Next.

7. In the Name field of the next screen, type Tom 
Ferguson. In the Title field, type President.
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Ferguson. In the Title field, type President.

8. Click Next.

9. If QuickBooks displays a message about missing 
information, click OK.

10. Close the Microsoft Word file without saving the 
letters.

11. Return to QuickBooks and click Cancel.



Editing QuickBooks Letters

To edit a QuickBooks Letter:

1. From the Company menu, choose Prepare Letters 
with Envelopes.

2. Select Customize Letter Templates.

3. Click “View or Edit Existing Letter Templates.”

4. Click Next.
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4. Click Next.

5. When QuickBooks prompts you to choose the letter 
template you want to view or edit, click Collection, 
and then select “Friendly collection” from the list 
of available letters.

6. Click Next.

7. Click your mouse pointer after the period at the 
end of the first sentence and the press the Space 
bar once. (You’ll insert a sentence into the 
paragraph.)



Editing QuickBooks Letters

8. Type Our records show that your balance is past due.

9. Click your mouse pointer after the word is in the sentence 
you just typed, and press the Space bar again.

10. From the Insert Collection Info. Fields drop-down list on the 
QuickBooks Collection Letter Fields toolbar, select 
Range(days) of Overdue Invoices.

11. From the Word File menu, choose Save As.
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12. Enter a new filename and click Save.

13. To see how this change affects the final letter output, close 
the letter file in Microsoft Word, click Use Template in 
QuickBooks, and go through the wizard again (all of your 
previous choices should still be selected).

14. When you get to the “Choose a Letter Template” screen, 
select the name of the file you just saved, and then click 
Next.

15. Close Microsoft Word.

16. Click Cancel in QuickBooks.



Using QuickBooks 
to Customize Forms



Customizing invoices

� QuickBooks lets you customize an invoice form 
to suit the needs of your business, but there may 
be times when you want to design a completely 
different invoice form.

� You can use the Layout Designer to create a new 
form design for your business. In the Layout 
Designer, you can move, resize, or change the 
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Designer, you can move, resize, or change the 
width of columns, turn on or off borders around 
fields, and control font type and size for each 
field.

� In the following exercises, you’ll use both the 
customize forms and Layout Designer features in 
QuickBooks to create a custom invoice.

Note that these features affect only the printed 
forms; you cannot customize the onscreen version of 
QuickBooks forms.



Creating new templates

To create a new invoice template:

1. From the Lists menu, choose Templates.

2. Click the Templates menu button, and then choose 
New.

3. Click OK to select the invoice form.

4. In the Template Name field, type My Invoice.
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4. In the Template Name field, type My Invoice.

5. Click the Fields tab.

6. To have the Due Date field display both on screen and 
on the printed form, click the Screen and Print 
columns for Due Date to select both checkboxes.

7. Clear the Screen and Print checkboxes for the P.O. 
field to remove the field from the form.



Changing field order on forms

� The lower half of the standard QuickBooks invoice 
form is where you enter details about the items or 
services purchased by the customer. You can 
change the order of these fields as they appear on 
your invoices.

� The Order column shows you how fields display 
from left to right on the invoice form. Currently, 

119

� The Order column shows you how fields display 
from left to right on the invoice form. Currently, 
Item is the first column and Amount is the last 
column. Suppose you want the Qty field to appear 
after the Item field, and before the Description 
field.



Changing field order on forms

To change the order of fields on a form:
1. Click the Columns tab.

2. Double-click the Order column in the Quantity row to select 
the number.

3. Type 2.

4. Double-click the Order column in the Description row to 
select it.
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select it.

5. Type 3.

6. Click the Footer tab.

7. Click the Company tab.

8. Select the Print Phone Number checkbox.

9. Click the Format tab.

10. Click the Printer tab.

11. Click OK to record the changes.

12. Close the Templates window.



Displaying your customized form

To display the custom form:

1. From the Customers menu, choose Create Invoices.

2. In the Template field, choose My Invoice
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Leave the Create Invoices window open.



Designing custom layouts for 
forms

Here are a few examples of what you can do 
with a custom layout:

� Give your company name, address, and logo special 
treatment on the form. For example, you could center 
your logo at the top of the form and put your 
company name and address in a special font 
immediately below the logo.
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immediately below the logo.

� Enlarge a custom field so that it can display more 
information.

� Position the customer’s billing address so that it 
coincides with the address window in the envelopes 
you use.

� Change the borders on fields, add background colors, 
and add extra text fields.

� Add multiple graphics to a form.



Changing the position of fields on forms

To move fields on forms:

1. In the Create Invoices window, click Customize.

2. Make sure that My Invoice is selected and click Edit.

3. Click Layout Designer.

4. Click the Bill To field.

5. Press and hold the Shift key.
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5. Press and hold the Shift key.

6. Click the field directly below the Bill To field (the 
field containing the words “This is sample text”).

7. Release the Shift key.

8. With the cursor over the selected fields, press and 
hold the left mouse button.

9. Drag the selected fields down about one inch.

10.Release the mouse button.



Changing the position of fields on 
forms (continued)

11. Select the field containing Rock Castle’s address.

12. Move the mouse over one of the dark squares on the 
bottom of the field and then hold the mouse button 
while you drag the bottom of the field up to a point 
just below the address—the goal being to get rid of the 
extra space below the address so you can place the 
phone number directly beneath it.
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13. Scroll to the bottom of the screen and select the 
Phone # field.

14. Click Remove.

15. Select the field containing the numbers 555-555-5555.

16. Holding down the mouse button, drag the field so that 
it sits just below Rock Castle’s address.



Changing field widths

To change the width of a field:

1. Select the field containing the telephone 
number and drag the right border further to 
the right while holding down the mouse button.

2. In the Layout Designer window, scroll until the 
Qty column is visible.
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Qty column is visible.

3. Click the Qty column to select it.

4. Click and hold the left mouse button on the line 
separating the Qty and Description columns.

5. While holding down the mouse button, drag the 
column line to the left (to the one-inch mark 
on the ruler).

6. Release the mouse button.



Changing field widths

� Release the mouse button.
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Changing fonts, borders, and colors

To change fonts, borders, and colors:

1. With the phone number field selected, click 
Properties.

2. On the Text tab, select Left for horizontal 
justification.

3. Click Font.

127

4. In the Size drop-down list, select 12, and then click 
OK.

5. Click the Border tab.

6. Click to remove the Top, Bottom, Right, and Left 
checkboxes.

7. Click OK to save your changes in the Properties 
window.

8. Click OK to save the changes in the Layout Designer.

9. Click OK to close the Customize Invoice window.



Previewing new forms

To preview the invoice:

1. To see how the printed invoice form will look, 
click the Print drop-down list on the Create 
Invoices window toolbar, and then choose 
Preview.

2. When you are finished looking at the preview, 
click Close.
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2. When you are finished looking at the preview, 
click Close.

3. Press Esc to close the Create Invoices window 
without saving.



Review activities

� Customize the Sales Receipt form to change the 
default title on the header from" Sales Receipt” 
to “Cash Sale.”

� Using the Layout Designer, make the columns for 
QTY and Rate narrower so the Description field is 
wider.

129

� Customize the P.O. form to include the Terms 
field.


